SMARTWIRE PROGRAMMING MANUAL
# Table of Contents

Introduction ............................................................................................................................................................. 0  
Technical Specifications ........................................................................................................................................... 1  
Becoming Familiar with the SmartWire Installation .............................................................................................. 2  
  Pre-Install notes: ................................................................................................................................................. 2  
Example Installation Overview ............................................................................................................................... 3  
DatalinkII Software Installation .............................................................................................................................. 5  
Configuration Files ................................................................................................................................................. 6  
  Stand Alone or with V-Net sensors, No Data Recorder ........................................................................................ 6  
  SmartWire with Data Recorder .......................................................................................................................... 7  
General Reading and Sending/Writing Configuration File Settings....................................................................... 8  
General Modifying of SmartWire Programming ..................................................................................................... 8  
SmartWire Programming ................................................................................................................................... 9  
General SmartWire Unit Overview ......................................................................................................................... 10  
Configuration File (setup file) ............................................................................................................................... 11  
SmartWire Main Unit Settings ............................................................................................................................... 12  
Outputs (channels 1-30)...................................................................................................................................... 14  
On/Off Conditions for Outputs ............................................................................................................................ 17  
  Setpoint Control Channel .................................................................................................................................. 19  
  Channel Status Bit Mask 1 .................................................................................................................................. 19  
  Channel Status Values ...................................................................................................................................... 19  
  Logic Example .................................................................................................................................................. 20  
Input Switches - Hardwired Direct ........................................................................................................................ 21  
Input Switches - Smart Panel or Smart Module ..................................................................................................... 22  
Real Time Viewing ............................................................................................................................................... 24  
  1-Start All Channels Live Data ............................................................................................................................. 24  
  2-Start Channel Live Data ................................................................................................................................ 25  
  3-Real Time Data on PC ................................................................................................................................... 26  
  Starting a Telemetry Session ............................................................................................................................ 27  
Example Programming (Walk through) .................................................................................................................. 31  
  Input Configuring (Walk through cont.) ............................................................................................................... 32  
  Output Configuring (Walk through cont.) .......................................................................................................... 33  
  Logic Configuration (Walk through cont.) ........................................................................................................ 35  
  Understanding Basic Logic Flow: ....................................................................................................................... 36  
SmartWire Firmware Update ................................................................................................................................. 37  
Channel/Pin Chart ................................................................................................................................................. 38
Disclaimer

Competition Systems Inc. Racepak make no representations or warranties of any type with respect to the contents in this manual. Competition Systems Inc. Racepak disclaim any implied warranties or fitness for any particular purpose. Competition Systems Inc. Racepak is not liable for any errors contained within or for incidental or consequential damages in connection with the supply, performance or use of the hardware and software or this manual.

Competition Systems Inc. Racepak reserve the right to revise this installation and user manual at any time, without obligation to notify any person of revisions.

Warranty

Competition Systems Inc. Racepak make every effort to insure our products and services are of the highest quality and standards. It is our intention to maintain a mutually beneficial and cordial relationship with each and every customer.

Competition Systems Inc. Racepak warrants all merchandise manufactured by Competition Systems Inc. Racepak against defects in workmanship or material for a period of six months after the data of purchase. This warranty applies to the first retail purchaser and covers only those products exposed to normal use or service. It does not apply to those products used for a purpose for which said products were not designed, or which has been altered in any way that would be detrimental to the performance or life of the product, or misapplication, misuse, negligence, or accident. Any part or product found to be defective after examination by Competition Systems Inc. Racepak will be repaired or replaced. Competition Systems Inc. Racepak assumes no responsibility for diagnosis, removal and/or installation labor, loss of vehicle use, loss of time, inconvenience or any other consequential expenses.

This warranty is in lieu of any other expressed or implied warranties, including any implied warranty or merchantability or fitness, and any other obligation on the part of Competition Systems Inc. Racepak, or selling dealer.

If you have any questions regarding warranty, please contact customer service at Competition Systems Inc. Racepak. 949-709-5555
Introduction

Solving the wiring complexity of a modern race car, the Racepak SmartWire is a fully programmable power control module. While traditional wiring provides control of vehicle electronic components through the routing of single, or multi-fuse, relay, and circuit breaker panels, the Racepak SmartWire functions as a central “command center” for all vehicle wiring.

Based on Racepak’s exclusive single cable V-Net technology, the Racepak SmartWire unit is the electronic “starting point”, with a direct main power connection from the vehicle battery to the SmartWire unit. Each output is user defined, both in function, current requirement and current limit via a USB connection to the user’s PC. The design of the SmartWire unit will reduce overall installation weight / clutter, while contributing to a quicker reacting electronic system, through the solid state switching design.

Manual activation can be achieved through the 12 hardwired direct inputs on the SmartWire unit, or through the use of the optional Racepak SwitchPanel or SwitchModule units. When utilized, a single small cable is routed to the SwitchPanel/SmartModule from the Racepak SmartWire unit, reducing wiring clutter. Users needing additional switch panel capabilities can easily expand through the use of an additional “jumper” cable to a second Racepak SwitchPanel/SmartModule.

The Racepak V-Net compatibility of the SmartWire unit insures a seamless integration with existing Racepak V-Net equipped vehicles. When connected with existing V-Net equipment, these items provide additional inputs, control modules and instrumentation, compared to when utilized as a standalone power control module.

This manual will provided you step by step guidance through the installation, setup, and operation of the SmartWire unit. During this process, the manual may refer to system worksheets and individual instruction sheets originally provided with other Racepak sensor modules and devices.

To get the most out of the Racepak SmartWire unit, it is highly recommended to thoroughly read the entire manual before installation and use of the Racepak SmartWire unit. In addition, test the SmartWire unit and settings/functions before use. The race track is not the place to determine something is not working properly!
Technical Specifications

Output Capacity: 125 Amps
Current Consumption: 180 mA typical operation (<1 mA in shutdown mode)
Min/Max Power Supply: 8-20 Volts
Operating Power Supply: 12-16 volt automotive applications.
Inputs: 12 hardwired direct (voltage triggered (>2.7V) or ground triggered (<2.5V)
Outputs: 30 (8 outputs @ 20 Amps, 22 outputs @ 10 Amps)
Response: 3.0 milliseconds max.
Programming: USB (or via V-Net when used with a V-Net data recorder)
Dimensions: Length 6.5” (16.51 cm), Width 5.5” (13.97 cm), Height 2.0” (5.08 cm)
Weight: 25.8 ounces (731.4 grams)

Note: All current ratings are for 12 volt operation. For 16 volt systems, subtract 25 percent.

Connections:
- Two - 23 pin Ampseal, (hardwired direct inputs, outputs, grounds and shutdown pin)
- One - 1/4” x 20 Main Stud, (main power supply)
- One USB mini (programming when utilized without a compatible data recorder)
- One Switch CAN bus (connection for optional Switch Panel and/or Switch Module)
- One V-Net CAN bus (connection for optional V-Net sensors and/or compatible data recorders)

Outputs are:
- Monitored for Current, Voltage, and Status
- Protected via user settable limits for over-current situations
- Protected from short circuits and/or thermal overload situations
- Function programmable as:
  - Constant On
  - Flash
  - Latch On
  - Single Pulse
  - Windshield Wiper (only available on channel 19)
- Time Delayed for On or Off
- Outputs are controlled via any combinations of:
  - Switchable inputs
  - Programmed logic operations;
    - (Equal to, Not Equal to, Greater than, Greater than or Equal to, Less than, Less than or Not Equal to)
  - V-Net attached sensors (Temperatures, Pressures, RPM, etc.)
  - Other Outputs
Becoming Familiar with the SmartWire Installation

This manual is designed to provide guidance through the programming of the SmartWire unit. Use of this manual, along with the SmartWire Installation manual, will provide complete installation and programming instructions. Below is an overview of a typical installation and setup.

1. Utilizing the SmartWire Software/Programming manual, install the DatalinkII software on PC
2. Install only the main power and grounds on the SmartWire
3. Connect SmartWire to PC using supplied USB cable
4. Utilizing the SmartWire Programming Installation manual, open the configuration file on PC
5. Sync the configuration file with the SmartWire
6. Name, program, and send each of the inputs (Hardwired direct inputs). Smart Panel/Smart Module and V-Net items can be programmed at this time if connected. Or, each can be programmed at a later date.
7. Name, program, and send each of the outputs (ensure correct Amperage rating for each device)
8. Wire each of the inputs per programmed settings (see Hardware Installation Manual)
9. Wire each of the outputs per programmed settings (see Hardware Installation Manual)
10. Test each of the input and output settings. Insure each circuit operates as intended

Pre-Install notes:

It is recommended to initially install the Main Power and Ground wires first in order to program each input and output. Once programmed, terminate and wire only the necessary connections. Do not terminate every connection, unless a device will be connected.

The SmartWire can be installed and utilized as a standalone unit (i.e. not connected to a data recorder) or is compatible with the following Racepak data recorders:

- V300 (firmware version 41 or higher)
- V300SD (firmware version 22 or higher)
- V500 (firmware version 56 or higher)
- IQ3 Logger Dash (firmware version 15 or higher)
- IQ3 Display Only non-logger Dash (firmware version 17 or higher)
- G2X Pro (firmware version 57 or higher)

If the PC does not meet the above firmware requirement, contact Racepak for update details.

Portions of this manual will call out two installing/programming types; Standalone AND with a Data Recorder. In Standalone mode, all programming is performed via USB cable between the PC and the SmartWire unit.

When utilized with Racepak V-Net sensors or in conjunction with a Racepak data recorder, programming is performed via serial connection between the PC and the data recorder unit.
Example Installation Overview

In a standard switch/device application, power is routed to a switch, with this switch controlling one device. Depending on the device current (Amperage) requirement, this switch controls a relay, when triggered, allows a large amount of current flow to the device. Activating the device requires manually flipping a switch.

**Standard switch installation:**

One switch for each device.

Switch on, device on.

**Basic SmartWire installation**

One switch for each device.

Switch on, device on.

Monitors on both devices for:
- Current (Amps)
- Voltage
- Status (on/off/blown fuse)

**Option #1 SmartWire installation**

One switch for both devices.

Switch on, both devices on.

SmartWire can toggle both devices on/off at set timer intervals

Monitors both devices for:
- Current (Amps)
- Voltage
- Status (on/off/blown fuse)

**Option #2 SmartWire installation**

One switch for manual override, V-Net sensor used for trigger

Switch on, devices on regardless of temperature input.

Switch off; SmartWire is programmed to automatically turn both devices on at user set temperatures based on V-Net input. SmartWire can toggle both devices on/off at set timer intervals

Sensor failure, SmartWire can be programmed to force devices on should temperature go outside sensor readable scale regardless of switch position.

Monitors both outputs/devices for:
- Current (Amps)
- Voltage
- Status (on/off/blown fuse)
Option #3 SmartWire installation in conjunction with Racepak V-Net data recorder

When connected to a V-Net data recorder, each sensor can be utilized for on/off function or logic control of each device connected to the SmartWire. Optional Racepak Switch Panels or Switch Modules can also added and connected to the SmartWire for more inputs and/or control.

Note: Most ignition and ECU systems require a direct main power connection. This main power connection must go directly to the battery. DO NOT connect the main power wire from these devices to the SmartWire outputs. Each of these devices will also have a small wire requiring an ignition switched power source. This small wire will connect to an output from the SmartWire.
DatalinkII Software Installation
The DatalinkII software is utilized to program the SmartWire unit. If a previous version of DatalinkII exists on the programming PC, update to the latest DatalinkII software (version 3.8.4 or higher), included with the SmartWire package.

Please note that “DatalinkII ” is the latest generation of Racepak software and supersedes the first generation known as DatalinkII. DatalinkII began with version 1.0. Therefore, DatalinkII version 3.4 would be a more recent version than DatalinkI version 5.5.

**NOTE: The following instructions update existing versions of DatalinkII software.**

During the program installation (step 7), select the unit to be utilized. Be sure to select “SmartWire”, as this will install the necessary files needed for the SmartWire unit.

To install the software

1. Close all/any programs before beginning the DatalinkII installation
2. Insert DatalinkII CD into CD/DVD drive of PC and close bay door
3. After a few seconds, the installation program should automatically start
4. “Welcome to the Install Wizard for DatalinkII”. Click Next
5. “License Agreement”. after reading, Click Yes
6. “Choose Destination Location” Default C:\Program Files\DatalinkII, Click Next
7. “Data Logger Installation and Support”, Select the check box for SmartWire, Click Next
8. “Select Program Folder”, Default is DatalinkII, Click Next
9. Install will start as noted by progress bar
10. If install for the first time, a “Welcome to the Install Wizard for PL-2303 USB-to-Serial” window will open, Click Next
11. “License Agreement”, after reading, Click YES
12. Installation PL-2303 Wizard Complete, Click Finish
13. Installation Wizard Complete, Click Finish
14. DatalinkII will now open
15. Software Installation Complete

Upon completion of installation, a new shortcut icon (shown right) will be added to the PC desktop with a title “DatalinkII Program”. Double click on the icon to start the DatalinkII software.
**Configuration Files**

The SmartWire unit is shipped from Racepak, with factory default settings. The end user must program the SmartWire for each particular application and wiring termination. To modify the settings of the SmartWire unit, a PC/laptop must be connected to the SmartWire in one of the two fashions shown below. A configuration file on the PC/laptop will then be opened and synced (READ from) the unit. Once the settings are read from the SmartWire, changes are made, and SENT/WRITE back to the SmartWire.

**Stand Alone or with V-Net sensors, No Data Recorder**

When utilizing the SmartWire as a standalone system (i.e. **not connected** via V-Net to a compatible Racepak Data Recorder), the factory car configuration file was copied onto the PC during the DatalinkII software installation, and will be listed as **SmartWire_Config**. The configuration file contains the setup information for the SmartWire unit, and each of the internal channels connected to the SmartWire unit. Use this file to modify the setup of the SmartWire or to view real time data.

1. Connect PC to SmartWire unit using the USB programming cable supplied with SmartWire unit system. The programming port is located next to the status lights on the SmartWire unit (shown right).

2. Ensure the main power is turned on for the SmartWire. The **Power** light will be on and lit **Red** when power is on.

3. Start the DatalinkII program by double clicking on the DatalinkII Program icon located on the Windows desktop of PC (shown right).

4. Open the car configuration file. To open the car configuration file, select **File** located in the main menu bar across the top of the screen and select **Open Car Configuration**. (shown right).

5. The dialog box (shown right) will be displayed
6. The list on the left-hand side of the **Select Configuration** dialog box will display all of the file folders in the RacePakData subdirectory (C:\RacePakData) that contain valid configuration files with a .rcg file extension. Select the SmartWire listing by selecting with the cursor.
7. The list on the right will now contain the list of configuration files contained in this folder. The factory configuration file for the SmartWire unit will be located here. Select the **OK** button
**SmartWire with Data Recorder**

If utilizing the SmartWire unit with any of the compatible Racepak Data Recorders (i.e. connected via V-Net to compatible Racepak data recorders), the same car configuration file utilized to program the data recorder will be also be utilized to program the SmartWire. The SmartWire will need to be synced into the existing car configuration file. Once READ in (synced), channel buttons for the SmartWire unit will appear in the data recorder configuration file.

1. Connect PC to **data recorder** using the programming cable supplied with **data recorder** system.

2. Ensure the main power is turned on for both the SmartWire AND data recorder. The **Power** light on the SmartWire should be lit **Red**.

3. Start the DatalinkII program by double clicking on the DatalinkII Program icon located on the Windows desktop of PC.

4. Open the car configuration file. To open the car configuration file, select **File** located in the main menu bar across the top of the screen, and select **Open Car Configuration**. (shown right).

5. The dialog box shown below will be displayed.

6. The list on the left-hand side of the **Select Configuration** dialog box will display all of the file folders in the RacePakData subdirectory (C:\RacePakData) that contain valid configuration files with a .rcg file extension. Select the item that matches data recorders serial number by left clicking on it with the mouse (shown in example is **V300SD_4447**).

7. The list on the right will now show the list of configuration files contained in this folder. Select the item which matches the **data recorder serial number** by left clicking, then the OK button.
General Reading and Sending/Writing Configuration File Settings

When connected to the PC, there is not a continuous communication between the SmartWire and PC configuration file. Communication is only during Reading and Sending commands. It is best to open a configuration file and perform a global Read command to insure the settings viewed on the PC are currently programmed in the SmartWire. To perform this global read command:

1. Open the Car Configuration as shown in the previous sections
2. Select Edit from the menu task bar located at the top of the screen
3. Select Read V-Net Config or select the Read button from the toolbar
4. A message log window will open and start scrolling indicating the reading is in process from the system
5. When the message dialog box reads “DEVICES READ SUCCESSFULLY”, click OK
6. Select File from the menu task bar located at the top of the screen
7. Click Save to save these current settings to the configuration file.

At this time, it is possible to modify the settings and send updates to the SmartWire. Each window has a Send Configuration button. This will send just the opened windows parameters.

1. To Send the entire configuration file to the SmartWire, select Edit from the menu task bar located at the top of the screen
2. Select Write V-Net Config or select the Write button from the toolbar
3. After any changes, periodically save the configuration file to ensure it stays in sync for offline viewing.

General Modifying of SmartWire Programming

To modify the SmartWire setup, perform the following steps:

1. Connect PC to Racepak unit using one of the previously mentioned methods
2. Apply power to unit
3. Start the DatalinkII program on PC and open the appropriate car configuration file
4. Select the device/channel to be modified
5. Make the desired modifications to the device/channel
6. SEND/WRITE the modified configuration to the device
7. Save the modified car configuration file
**SmartWire Programming**

Using the previous instructions, it is now time to begin programming / configuration of the SmartWire unit. The following general steps are performed to setup input channels, setup the output channels and program the logic for the output channels to enable the output to perform its intended purpose.

1. Select the **INPUT** channel to be program
2. Configure the input channel for its intended purpose and **Send** these settings to the SmartWire
3. Select the **OUTPUT** channel to be program
4. Configure the output for its intended device and **Send** these settings to the SmartWire
5. Configure the outputs **ON CONDITIONS** and **LOGIC** for proper control of the device and **Send** these settings to the SmartWire
6. **SAVE** the updated car configuration file on the PC

The following pages will describe each window within the SmartWire configuration file. Using the Hardware Installation Manual **AND** the Software/Programming Manual, along with using the previously mentioned instructions, should provide a better understanding of the steps of installing and programming the SmartWire unit.

At this point it would be best to have a generalized plan for the outputs and inputs of the SmartWire system. This plan should include the following steps:

1. What will be connected and used as the inputs (switches/buttons)?
   - Starter button, Ign. switch, Light switch, Fuel Pump, Fan, Water Pump, etc.

2. What will the outputs connect to (devices)?
   - Starter Solenoid, Ignition system, ECU, Lights, Fuel Pump, Fans, Water Pump, etc.

3. What Conditions/Logic will be used to control the outputs?
   - Starter button for Starter Solenoid activation
   - Ignition switch to turn on Ignition system, ECU, and Fuel Pump
   - Light Switch to turn on all Lights
   - Cooling Switch to turn on Fans and Water Pump

**Allow ample time to program and wire the SmartWire.**

---

**Warning:** It is recommended to initially install the Main Power and Ground wires first in order to program each input and output. Once programmed, terminate and wire only the necessary connections. **Do not terminate every connection, unless a device will be connected.**

To get the most out of the Racepak SmartWire unit, it is highly recommended to thoroughly read the entire manual before installation and use of the Racepak SmartWire unit. In addition, test the SmartWire unit and settings/functions before use. The race track is not the place to determine something is not working properly!
General SmartWire Unit Overview

Two 23 Pin Amp connectors for:
- Thirty Outputs: Output to all vehicle devices requiring switched power
- Twelve Hardwired Direct Inputs: Inputs from switches and buttons
- Three SmartWire Ground: Main grounding for SmartWire unit
- One Shutdown Pin: Main power shutdown for SmartWire when grounded

Main Stud:
Main power for SmartWire from battery
11.5 volts minimum for typically operating

Switch Port:
Connection for External Switch Panels/Modules if utilized

V-Net Port:
Connection for V-Net devices if utilized

USB Programming Port:
Used for programming when no V-Net data recorder is connected.

Note: Not used when SmartWire is utilized with a V-Net Data recorder. Programming will then be performed through the data recorder.

Lights:
Power:
- Red when powered
Status:
- Green when no fuses are blown
- Red when a fuse is blown

<table>
<thead>
<tr>
<th>Description</th>
<th>Power Light</th>
<th>Status Light</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Power¹</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Powered on with no issues, Normal</td>
<td>Red</td>
<td>Green</td>
</tr>
<tr>
<td>Powered on with a Blown Fuse²</td>
<td>Red</td>
<td>Red</td>
</tr>
<tr>
<td>Firmware Update in progress</td>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>Firmware Update failure</td>
<td>Flashing Red</td>
<td>Off²</td>
</tr>
</tbody>
</table>

¹No power could be due to no power at main stud, no ground to main unit, or Shutdown pin is grounded.
²Blown fuse on one or more circuits

⚠️ NOTE: The SmartWire is designed as a switching control unit. The SmartWire unit is not designed as a main power feed for certain high current items. These items include, but not limited to ignition and electronic fuel systems. Refer to device manual for power requirements.

⚠️ If the manufacturer recommends the main power be connected to the main direct battery power, follow the manufacturer’s requirement and DO NOT connect items through the SmartWire.
**Configuration File (setup file)**

Viewed by opening the car configuration file by one of the below methods:
- Standalone – File → Open Car Configuration → SmartWire → Click OK
- Via Data Recorder – File → Open Car Configuration → The data recorder → Click OK

**NOTE:** When via Data Recorder, the SmartWire channels will only appear after the SmartWire has been connected and synced up with the data recorder by performing a Read V-Net Config.

**NOTE:** If optional Switch Panel and/or Switch Module is installed, a separate channel, for each, may appear with what is shown below. See Switch Panel Section for programming details.

Next to the graph tab, a tab appears with a blue wrench. This blue wrench designates the configuration file tab. Listed below the configuration tab are the buttons for each of the channels on the SmartWire unit.

**Channel buttons:**

By right-clicking on each channel button, the channel settings for that particular channel are available.

- **SmartWire#1**: Channel button to access the SmartWire main unit system settings (SmartWire Parameters)
- **SM1 Output #1 – SM1 Output #30**: Output channels 1-30. Each of these buttons accesses the channel settings for each SmartWire output. See inside back cover for pin locations on main connectors.
- **SM1 Switches**: Hardwired input switches to SmartWire unit, input channels 1-12. This channel button contains the settings for each of the 12 input connections to the SmartWire. See inside back cover for pin locations on main connectors.
SmartWire Main Unit Settings

- **Device Name**: Name of SmartWire unit. 
  Default=SmartWire #1
- **Type**: Device Type *Non-programmable*
- **VNet Update Rate**: Sample rate of the broadcast of this channel out to other devices/channels on the V-Net. *Default=20*
- **VNET ID**: ID of the broadcast of this channel out to other devices/channels on the V-Net. *DO NOT CHANGE-FOR ADVANCED USERS ONLY!*
- **Switch Bus Update Rate**: Sample rate of the broadcast between SmartWire unit and items connected to the switch port on the SmartWire unit. *Default=10*
- **Logger Sample Rate**: Logging sample rate of this channels when used with a Racepak data logger. *Default=20*
- **Unit Serial #**: Serial Number of SmartWire unit. *Non-programmable*
- **Firmware Version**: SmartWire unit internal software version (*see firmware update section for details*)
- **SmartWire Device Number**: SmartWire device number. Used when multiple SmartWire units are installed in same vehicle *Default=1* (changing this number will reset unit to factory settings)
- **VNET Bus Terminating Resistor**: Each end of the V-Net bus must be terminated. This setting allows the user to either enable or disable the internal resistor. *Default=Off DO NOT CHANGE-FOR ADVANCED USERS ONLY!*
- **Switch Bus Terminating Resistor**: Each end of the Switch bus must be terminated. This setting allows the user to either enable or disable the internal resistor. *Default=On DO NOT CHANGE-FOR ADVANCED USERS ONLY!*
- **Supply VNET Bus Power When**: This setting is used to manage if/when the V-Net system receives power from the SmartWire unit. This manages the power to the items connected to the V-Net port on the SmartWire unit. *Default=Always On*
• **Supply Switch Bus Power When:** This setting is used to manage if/when the switch port receives power from the SmartWire unit. This manages the power to the items connected to the switch port on the SmartWire unit.  *Default= Always On*

• **VNET Bus Gateway:** *Default=On DO NOT CHANGE-FOR ADVANCED USERS ONLY!*

• **Internal Temp Units:** Determines unit of measure for the internal temperature sensor when logged.  *Default= °F*

• **Real-Time Telemetering Setup (Graph View):** To perform a Real-Time graphing, channels must be selected and sent to the SmartWire unit using the Real-Time Telemetering Setup windows. (See Real-Time Viewing section)

**Buttons (lower right of window):**

• **Start All Channels Live Data (List View):** When a real-time graph is not required, this button can be selected to show a real-time list of channels. Shows SmartWire outputs and hardwired inputs only.

• **Start Channel Live Data:** Shows real-time data for this one particular window.

• **Send Configuration:** Sends the windows current values of this channel to the SmartWire

• **Read Configuration:** Reads the values from the SmartWire and populates the window with the currently programmed values of this channel.
Outputs (channels 1-30)

Accessed by right-clicking on the SM1-SM30 output channel button (Refer to channel/pin chart on last page of this manual)

- **Channel Name**: Can be changed to match the device this output is connected to for ease of future programming. It is recommended to start the name with a reference to the channel number (ex: output #12 for Fuel Pump = “O12 Fuel Pump”). Name must start with a letter. 
  
  *Default=SM1 Output #n*

- **Type**: SMARTWIRE 20A or SMARTWIRE 10A Designates the particular channel type. *Device connected to this channel should not exceed the listed current rating. Non-programmable*

- **Channel Mode**: Enabled or Disabled, designates channel output mode *Default=Enabled*

- **Vnet ID**: ID of the broadcast of this channel out to other devices/channels on the V-Net.  
  
  *DO NOT CHANGE-FOR ADVANCED USERS*

- **Unit Serial #**: Serial number of the SmartWire unit this output pertains to.

- **Output Function**: Constant On, Flash, Latch On, Single Pulse, Windshield Wiper; *Default=Constant On*

  - **Constant On**: When on condition is met (true), output will remain on until on condition is not met (false). On/Off Delay times are active when selected.

  - **Flash**: When on condition is met (true), output will flash on/off until on condition is not met (false). On/Off Delay times and Flash On/Off times are active when selected.

  - **Latch On**: When on condition is met (true), output will latch (lock) on and remain on regardless of on condition (true or false). In order to reset, master power must be cycled to off position. On Delay time is active when selected.

  - **Single Pulse**: When on condition is met (true), output will activate once regardless of condition. On Delay and Pulse Time is active. Once Pulse Time is finished, condition must go false in order to restart output on next true condition.

  *NOTE: Once activated, the output will run through the cycle regardless of the on-condition. Output is active once on-condition is met regardless how long the on condition remains true.*
- **Windshield Wiper:** Only available on output channel 19 (pin A17). Allows a direct method to be utilized for windshield wiper motor/parking operation. When a direct method is used, a reference channel named Wiper Brake Control Channel becomes selectable. An input channel must be selected in order to Park the wipers in the correct location. This is the channel that will be the input referenced for the Park position. See SmartWire Installation manual for further details.

  - **Output Number:** Designates the output channel number (not actual pin/connection number)
  - **Missing VNET Message Logic:** Designates the condition for any of the Setpoint Control Channels, used in this particular channels operation, should they become inactive/missing on the VNET CAN bus.

  *Example:* A water temp sensor is used in the logic to turn on/off this output to control a fan. When the water temp goes above 180F, the condition for this would go True, therefore making the fan output condition True and the fan would turn on. If by chance, this water temp sensor module becomes inactive/unplugged at any time then the “Missing VNet Message Logic” setting will be referenced for this channel. In a case where the water temp sensor module becomes inactive/unplugged, if set to “Condition True” this would turn the fan on. If set to “Condition False” the fan would never turn and overheating will occur.  
  
  Default=Condition False

  *Note:* For critical controlled items, a range check should be performed on any input channel (sensor) associated with the output. This range should be taken into consideration when programmed into the True/False settings, to ensure the output will be in a non-problematic state should the input channel (sensor) fail or go outside its operating range.

  - **Fuse Current:** Fuse value, this is the max current that is allowed before fuse is blown (output off). Higher numbers than the channel output are possible only for surge (momentary) times. Default=20 on 20 amp Type, 15 on 10 amp Type.
  - **Logger Sample Rate:** Logging sample rate of this channels when used with a Racepak data logger. Default=off
  - **Current Graph Min:** Minimum graph scaling for the Current (Amp) Y axis of this channel. Pertains only to logging of this channel. Default=0
  - **Current Graph Max:** Maximum graph scaling for the Current (Amp) Y axis of this channel. Pertains only to logging of this channel. Default=35
  - **Volts Graph Min:** Minimum graph scaling for the Volts Y axis of this channel. Pertains only to logging of this channel. Default=0
• **Volts Graph Max**: Maximum graph scaling for the Volts Y axis of this channel. Pertains only to logging of this channel. Default=35

• **Fuse Reset Delay**: Number of seconds between blown fuse and resetting of the fuse. Default=2

• **Max Fuse Retries**: Number of times the system will try to reset a blown fuse. Default=100

• **VNet Update Rate**: Sample rate of the broadcast of this channel out to other devices/channels on the V-Net. Default=10

• **Switch Bus Update Rate**: Sample rate of the broadcast between this channel and items connected to the switch port on the SmartWire unit. Default=10

• **On Delay Time**: Once the condition is true, this is the amount of delay before output becomes active. Default=0

• **Off Delay Time**: Once a true condition goes false, this is the amount of delay before the output becomes inactive. Only shown when Output Function set to Constant On or Flash Default=0

• **Flash On Time**: Once the condition is true and the On Delay Time is finished, this is the amount of time the output will be active. Once this time is finished, the Flash Off Time becomes active. Only shown when Output Function set to Flash Default=0.5

• **Flash Off Time**: Once the Flash On Time is finished, this is the amount of time the output will be inactive. Once this time is finished, the Flash On Time becomes active. Only shown when Output Function set to Flash Default=0.5

• **Pulse Time**: Once the condition is true and the On Delay Time is finished, this is the amount of time the output will be active. Only shown when Output Function set to Pulse

**Buttons (lower right of window):**

• **On Condition**: Shows the On/Off Conditions logic window for this channel

• **Start Channel Live Data**: Starts the Real-Time window for this channel

• **Send Configuration**: Sends the windows current values of this channel to the SmartWire

• **Read Configuration**: Reads the values from the SmartWire and populates the window with the currently programmed values of this channel.
On/Off Conditions for Outputs

Accessed by clicking the On Condition button within any of the Output channel windows.

- **Setpoint Control Channel:** The pull-down boxes #1-#10 allow selection of channels, which are used to reference for On/Off conditions of this output. Channel name and its ID number are shown.

- **Operation:** *Not Equal To, Equal To, Greater than, Greater than or Equal to, Less than, Less than or Equal to* Operators used for status of the Setpoint channel

- **True Condition:**
  - *Not Equal To, Equal To* - Value used for the Setpoint Channel to be **True**.
  - *Greater than, Greater than or Equal to, Less than, Less than or Equal to* – Value used for the Setpoint Channel to become **True**. Requires a False condition to be set (*Hysteresis*)

- **False Condition**
  - *Not Equal To, Equal To* - Value used for the Setpoint Channel to be **False**.
  - *Greater than, Greater than or Equal to, Less than, Less than or Equal to* – Value used for the Setpoint Channel to become **False**. Requires a False condition to be set (*Hysteresis*)

*Hysteresis* – When the *Greater than, Greater than or Equal to, Less than, Less than or Equal to* is selected, both a True and False condition must be entered. To prevent oscillation and/or chattering (i.e. undesirable rapid changes between the two condition states, True or False), a small difference between the True and False is required. Depending on the channel and desired condition, this difference can either be small or large. If the difference is too small, this can cause the output channel to turn on/off rapidly, causing undesirable effects. A larger difference in set points prevents chattering of the output channel.
- **Greater than, Greater than or Equal to**, requires a higher true condition value vs. false condition value
- **Less than, Less than or Equal to**, requires a lower true condition value vs. false condition value

**Example:** A water temp sensor is used in the logic to turn on/off this output to control a fan. When the water temp goes above 180°F, the condition for this would go True, therefore making the fan output condition True and the fan turns on. Of course with the fan on, the temperature will start to drop below the 180°F setting therefore shutting the fan off. In this instance, the fan would toggle on/off at this temperature. To keep this toggle effect from happening, a lower shutoff value should be used such as 160°F (example shown).

**NOTE:** For critical controlled items, a range check should be performed on any input channel (sensor) associated with the output. This range should be taken into consideration when programmed into the True/False settings. This will ensure that the output will be in a non-problematic state should the input channel (sensor) fail or go outside of its operating range.

- **True Delay:** Once the Setpoint channel true condition is met, a time delay can be entered before it is evaluated by the channel logic as **True**, thus controlling the output channel.
- **False Delay:** Once the Setpoint channel false condition is met, a time delay can be entered before it is evaluated by the channel logic as **False**, thus controlling the output channel.
- **Logic Area:** This area to the right of the On/Off Conditions window is where the output channel logic is entered. By right clicking in this area, select the enabled Setpoint Control Channels and their conditions for use in the AND / OR logic to control the status of the channel output.
Setpoint Control Channel

When selecting SmartWire outputs (as opposed to inputs and V-Net inputs) for the Setpoint Control Channel, the following options are presented:

- Current- shown as the main channel name next to the + sign
- Voltage- shown below main channel name after the + is selected
- Status- shown below Voltage

In the example shown on right, the main channel name (SM1 Output #1 x1b0) is the Current (Amp) value. By clicking the + sign next to the channel, the channel Voltage or channel Status can be selected.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Name</td>
<td>Current</td>
<td>Output current in Amps, Resolution 0.5 Amps</td>
</tr>
<tr>
<td>Channel Name - Voltage</td>
<td>Voltage</td>
<td>Voltage on output, Resolution 0.1 volts</td>
</tr>
<tr>
<td>Channel Name - Status</td>
<td>Status</td>
<td>8 bit mask, see channel status below</td>
</tr>
</tbody>
</table>

Channel Status Bit Mask 1

<table>
<thead>
<tr>
<th>Bit</th>
<th>Value</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>ON/OFF</td>
<td>Bit set when output is on.</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>ON DELAY</td>
<td>Bit set when output is waiting for On Delay Time to expire before turning on.</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>OFF DELAY</td>
<td>Bit set when output is waiting for Off Delay Time to expire before turning off.</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>LATCHED ON</td>
<td>Bit is set when output is latched on. Only possible when Output Function is set to Latch On.</td>
</tr>
<tr>
<td>4</td>
<td>16</td>
<td>NOT USED</td>
<td>Open for future use.</td>
</tr>
<tr>
<td>5</td>
<td>32</td>
<td>NOT USED</td>
<td>Open for future use.</td>
</tr>
<tr>
<td>6</td>
<td>64</td>
<td>RETRY LIMIT</td>
<td>Bit sent when Max. Fuse Retries setting is reached.</td>
</tr>
<tr>
<td>7</td>
<td>128</td>
<td>FUSE BLOWN</td>
<td>Bit set when output fuse is blown because the Fuse Current setting has been exceeded.</td>
</tr>
</tbody>
</table>

Channel Status Values

The status bit values are additive. For instance, during a delay off condition the Status will be 5 since the output is ON (value 1) and the OFF DELAY (value 4) bit is set.

**NOTE:** Once the logic area is completed, click OK and click the Send Configuration button to send these changes to the main SmartWire module. Be sure to save the updated configuration file.
**Logic Example**

The example below is for an output connected to a Fuel Pump. An Oil Pressure sensor is installed via V-Net. The Ignition Switch, Fuel Pump Switch and MSD 2 Switch are connected via the Switch Panel. The example shows;

Turn on the output channel (Fuel Pump) when the following conditions are True:

- Oil Press is above 10psi (greater than 10) “&” Ignition Switch is on (equal to 1) “OR” Fuel Pump Switch is on (equal to 1)

This would turn the pump on anytime the engine has oil pressure “&” the ignition switch is on “OR” the Fuel Pump Switch is on (equal to 1)

The Fuel Pump would turn on if the fuel pump toggle switch was turned on (True) regardless of any other conditions. This could be viewed as a “force on” switch possibly used for priming.

The “&” value connects two logic conditions together meaning both would have to be True in order for the output channel (Fuel Pump) to be activated.

The “OR” value separates the logic conditions. If ANY of the logic conditions are True, the output channel (Fuel Pump) would be activated and remain on until all logics are False.

**NOTE:** There is one Setpoint Control Channel (MSD 2 Switch) that is enabled, but not used anywhere in the logic area; therefore this Setpoint Control Channel will not affect anything on this output channel.

All logic conditions are added/removed by right clicking in the Logic area.
Input Switches - Hardwired Direct

Accessed by right-clicking on the SM1 Output channel button (Refer to channel/pin chart for wiring on last page of this manual)

- **Channel Name**: Main channel name for the 12 Hardwired Switched Inputs. Change only if more than one main SmartWire module is on the vehicle. Default=*SM1 Inputs*, *User-programmable*

- **Vnet ID**: Broadcast ID of this channel out to other devices/channels on the V-Net. Requires a change only if more than one SmartWire unit is installed on vehicle. Default=*SmartWire 1 Switches x190*, **DO NOT CHANGE** FOR ADVANCED USERS ONLY!

- **Logger Sample Rate**: Logging sample rate of this channel when used with a Racepak data logger. Default=*50*

- **Type**: Device Type

- **Unit Serial Number**: Serial Number of SmartWire unit

- **Individual Switches**: Programming area for the 12 Hardwired Switched Inputs
  - **Switch Number**: Designates the input channel number (not actual pin/connection number)
  - **Pin Number**: Physical pin/connection number for each switch input. This number refers to the pin location in each of the two main SmartWire Connections A or B.
  - **Name**: Channel names for each of the 12 Hardwired Switched Inputs. Can be changed to match the device this switch or input is controlling. It is recommended to start the name with a reference to the type (ex: Hardwired Direct Input #2 for Fuel Pump = “HDIN#2 Fuel Pump”). Name must start with a letter. Default=*SM1 Sw #n*
  - **Trigger Level**: Designates if this input is to be Ground Triggered or Voltage Triggered to be True.
    - Ground Trigger: Input is triggered/active when the input is grounded.
    - Voltage Trigger: Input is triggered/active when it has a voltage above 2.8v applied.

**Buttons (lower right of window):**
- **Start Real-Time Display**: Shows real-time data for this one particular window.
- **Send Configuration**: Sends the windows current values of this channel to the SmartWire
- **Read Configuration**: Reads the values from the SmartWire and populates the window with the currently programmed values of this channel.
Input Switches - Smart Panel or Smart Module

**NOTE:** The Switch Panel will need to be added to the configuration by performing a Read V-Net Configuration before the SP1 Switches channel button appears.

- **Switch Panel Name:** Channel name for the Switch Panel (optional, sold separately). Change only if more than one Switch Panel is connected to one SmartWire module. *Default=SP1 Switches*
- **Unit Serial#** Serial Number of Switch Panel unit, *Non-programmable*
- **Type:** Device Type, *Non-programmable*
- **Vnet ID:** V-Net ID for the Switch Panel. Change only if more than one Switch Panel is connected to one SmartWire module. *Default=SmartWire 1 Switches x190*
- **Logger Sample Rate:** Logging sample rate of this channel when used with a Racepak data logger. *Default=20*
- **Switch Names:** Name of each switch. Can be changed to match the function of each switch. It is recommended to start the name with a reference to the type (ex: Switch Panel Input #2 for Ignition = “SP#2 Ignition”). Name must start with a letter. Keep in mind each switch can have multiple functions/outputs due its ability to be used in multiple output control logic windows.

  *Example:* one switch can turn on multiple items (outputs) such as fuel pumps, ignition system together along with other outputs of the SmartWire with one flip of the switch. This along with other logic and Time Delay features can be used to stagger outputs with other inputs/outputs.
• **Status IDs:** The Status ID represents action of the LED lights above the toggle switches. The Status ID can be used to simply monitor the status of the toggle switch (Switch On x0) or to indicate the status of any selected output by selecting the channel in the pull-down menu desired to monitor. The Status ID can monitor any selected output channel, regardless of the output channel the switch actually controls.
  - No Light - indicates output channel is off
  - Green Light - indicates output is on with no delays or blown fuses
  - Orange Light - indicates output has a delay in effect, either waiting to turn on, or waiting to turn off.
  - Red Light - indicates a blown fuse.

  **NOTE:** The Status ID is not selectable for the push button light. This light has two functions:
  1. Shows the operation of the push button (no light off, green light when pushed)
  2. Shows switch panel has power by a green blink approximately every 4 seconds.

• **Switch Bus Terminating Resistor:** Determines if the switch panel is internally terminated. Terminating resistor should be ON if one switch panel is installed. If more than one switch panel is installed, the last switch panel should have the terminating resistor turned on, all others should be turned OFF. The SmartWire unit has a setting for its Terminating resistor that needs to be turned ON and the last Switch Panel or Switch Module should have its Terminating resistor turned ON.

**Buttons (lower right of window):**
- **Start Real-Time Display:** Shows real-time data for this one particular window.
- **Send Configuration:** Sends the windows current values of this channel to the SmartWire
- **Read Configuration:** Reads the values from the SmartWire and populates the window with the currently programmed values of this channel.
**Real Time Viewing**
The SmartWire has three types of real-time viewing options. To view any of these:

1. Connect the PC to the SmartWire unit either directly using the USB programming cable OR through a compatible Racepak data recorder using its programming cable.
2. Ensure main power is on for the SmartWire (power light on SmartWire is solid red)
3. Start the DatalinkII program on the PC
4. Open the car configuration file for the SmartWire File ➔ Open Car Configuration ➔ SmartWire
5. Right click the channel button for the channel wished to view
6. Refer to 1 of the 3 below Real-Time options

---

### 1-Start All Channels Live Data

Available in the main SmartWire window accessed by right-clicking on the SmartWire channel button.

This window shows a list of all channels within the main SmartWire unit. For diagnostic reasons, channel number, channel name and the pin number are shown.

Current column is the channels Current (Amp) in live time.

Voltage column is the channels Voltage (Volts) in live time. This is the voltage on the output and indicates the power at the connector for this pin. Assuming there are no connection issues between this pin on the connector and the device this pin is connected to, the device should be powered on.

Status column simply show the outputs current status (On/Off).

On column can be clicked on/off to force this channel active.

Located in the bottom row are on/off status for each of the Hardwired Direct Input Switches 1-12. If any input switch is activated (physically activating the switch/button connected to the particular channel), a green dot will appear in the box located below its channel number listing (Switch: 1-12).

*Ensure it is safe to activate the channel. Once clicked, this output channel will be active until clicked off. (Example: Should the Engine Starter output channel be selected the starter will activate and continue to be on until channel is clicked off)*
2-Start Channel Live Data
Available in all SmartWire channel windows.

By clicking the Start Channel Live Data button, the live values for the currently opened window will appear.

Main SmartWire
Window shows:
- Voltage at Main power Stud
- Internal Temperature of SmartWire
- Number of Blown Fuses

Output Channels
Window shows:
- Current: Amperage on channel
- Voltage: Volts on channel
- Status: status (On/Off)

Hardwired Direct Input Switches
Window shows:
- Input Status: (On/Off)

Optional Switch Panels
Window shows:
- Switch Status: (On/Off)

NOTE: The physical light on the switch panel may not turn on if the Status ID is set to one of the output channels.
3-Real Time Data on PC

Real Time data from the SmartWire unit can be displayed and recorded on the PC computer using the DatalinkII program. However, before viewing real-time data, first setup the real time parameters in the SmartWire units’ main window by selecting which channels desired to display/record during the real-time session. The below steps should be performed while connected to the PC and the SmartWire unit powered on.

Right-click on the SmartWire channel button

An edit dialog box will be displayed. In the center of the dialog box will be a Real – Time Telemetry Section. This section will contain two lists. The list on the left-hand side of the telemetry section will include all of the channels currently being monitored by the SmartWire unit. The list on the right-hand side of the telemetry sections includes all those channels that will be displayed during a real time telemetry session.

To add a channel to the telemetry list, highlight the name of the channel in the left-hand list, and click on the right arrow button to add the selected channel to the real-time channel list. To remove a channel from the real-time channel list highlight the name of the channel in the right hand list and click on the left arrow button.

**Remember that only channels in the right hand list will be displayed during a real time telemetry session.**

Once the channels desired to display are selected, send the selected channels to the SmartWire unit. Do this by clicking the **Send Configuration button**

Once the SmartWire unit is programmed for the channels desired to real-time, the configuration file must be saved. To perform this function, select **File** in the menu bar and select **Save** or by clicking the Save icon in the toolbar.
**Starting a Telemetry Session**

The next step is to start a telemetry session. Select the Telemetry icon or go to File and select New Telem Session.

A dialog box, as shown below, will be displayed which allows selection of the configuration file to use for this session.

Select the configuration file named SmartWire. A dialog box will then be displayed to allow entry of the session information (the same as when uploading run data). Since this is most likely a system test, select the year and enter TEST (or any name that would reference this particular session) in the Track dialog box. The system will enter the date and time.

Select Next, and depending on the configuration file, additional dialog boxes may be displayed. These are part of the Run Log sections that are user programmable to allow test information to be entered during the download process. Fill out the information as appropriate and click Next or click OK to continue on if no information is entered.
The file save dialog box will then be displayed. Select **Save** if saving this file or click the **Cancel** button. Clicking **Cancel** will still advance to the real-time session window, but no file will be saved at this time. The opportunity to save the session will be present, later.

A new file tab with the channel data will be opened. This file tab is designated with a blue floppy disk icon. (shown below).

In view should be the channel buttons across the top area of the window for each channel selected. Each channel will have -### next to it. This is normal as the session window is open, but the real-time session hasn’t yet been started.

The real time session is controlled via two icons located below the context sensitive help icon in tool bar. Only one icon will be active at a time depending on the status of the telemetry session. The **Start Data Acquisition** icon is shown active on the left. The **Stop Data Acquisition** icon is shown active on the right.
To start the real time data acquisition, click on the **Start Data Acquisition** Icon at the bottom of the tool bar. Once the real time data acquisition has been started, the value -### on each channel will change to the live value of each for each channel shown.

For each channel there are multiple values that can be displayed. By clicking the down arrow, other parameters of the channel will be shown.

**Main SmartWire**
Channel shows:
- Voltage at Main power Stud
- Internal Temperature of SmartWire
- Number of Blown Fuses

**Output Channels**
Channel shows:
- Current: Amperage on channel
- Voltage: Volts on channel
- Status: status (see table)

<table>
<thead>
<tr>
<th>Value</th>
<th>Output Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>1</td>
<td>On</td>
</tr>
<tr>
<td>2</td>
<td>Delay On</td>
</tr>
<tr>
<td>5</td>
<td>Delay Off</td>
</tr>
<tr>
<td>9</td>
<td>Latched On</td>
</tr>
<tr>
<td>128</td>
<td>Blown Fuse</td>
</tr>
<tr>
<td>192</td>
<td>Blown Fuse, Retry</td>
</tr>
</tbody>
</table>
**Hardwired Direct Input Switches**

Channel shows:

- Input Status: (On/Off)
  - 0 = Off
  - 1 = On

**Optional Switch Panels**

Window shows:

- Switch Status: (On/Off)
  - 0 = Off
  - 1 = On

To select a channel for graphing, simply click on the parameter desired to graph. A color will be designated to the channel parameter and the graph will have a line in it with a matching color indicating the value. To remove the channel from graphing, simply click on it again and the color will be removed. Each time select, a new color will be presented.

To stop the data acquisition, click on the Stop Data Acquisition icon located at the bottom of the tool bar. The real time data acquisition session will be suspended.

If desired to continue the real time data acquisition, simply click on the Start Data Acquisition icon. The telemetry session will restart at the same point it was suspended. If desired to restart the session from the beginning, select Erase from the Telemetry main menu. All previously recorded data will be erased from the file.

If desired to save the data, stop the data acquisition, and click the Save icon located in the tool bar, or select File from the main menu and select Save.
Example Programming (Walk through)

The following pages will present the complete setup and programming of a channel. For the following example, the intent is to configure an input for a “Starter Button” and have it activate the output for the “Starter Solenoid”. The Starter Button will be wired using one of the Hardwired Direct Inputs on the SmartWire unit:

1. Connect PC to the SmartWire using one of two methods
   a. Standalone - with V-Net sensors, no data recorder – Use the provided USB Programming Cable connected to the SmartWire unit.
   b. Via Data Recorder - Use the data recorder’s programming cable connected to the data recorder

2. Confirm the SmartWire unit has power verifying the Power Status light located on the main unit.

3. Open the DatalinkII program by double-clicking the DatalinkII icon found on the computer’s desktop

4. Open the configuration file
   a. Standalone - File→Open Car Configuration→SmartWire→Click OK
   b. Via Data Recorder – File→Open Car Configuration→The Racepak data recorder→Click OK

5. Once the configuration is opened, the configuration should be synced with the system. To perform this, select Edit→Read VET Config or click the Read icon in the toolbar

6. A message log window will open and start to scroll indicating the reading process has begun, (if an error is encountered, verify that the power is on, and the communication cables are correct. Click OK. Then click “yes” to scan all COM ports, repeat step 5)

7. Once complete, the message log window will show “DEVICES READ SUCCESSFULLY”

8. Once sync’d up and communicating with the SmartWire, the next step is program the input channel. For this example, we are going to use a hardwired input.
Input Configuring (Walk through cont.)

1. Right click on the channel button listed as SM1 Inputs.

2. Select an available switch under the Individual Inputs area (shown right). For this example we’ll use Input 1. Take note of the Pin # for this input as this will be the pin on the 23 pin connector used to connect to the button. Pin # A10.

3. In the name, type in a name that represents what this input will be. For this example, we’ll type in **HDW1#1 Starter**. The name represents Hardwire Direct Input # 1 Starter, for starter button. This will make it easy for future reference of this channel in later programming.

4. Under the Trigger Level area, click on the drop-down arrow and select the correct “Trigger”, Ground or Voltage. In this example, the **Voltage Trigger** should be selected.

   **NOTE:** If this was set for Ground Trigger, should the wire short against ground somewhere between the SmartWire and the ground source, the starter would engage and stay engaged. For this application, Voltage Trigger is a safer choice.

5. When set to Voltage Trigger, input channel #1, pin A10 will require a voltage signal greater than 4 volts to be applied to trigger this input. Considering this is for a Starter, a momentary button connected to a power source will be used to trigger the input.

6. Once the name and trigger level has been set, we can send this change to the SmartWire by clicking the “SEND Configuration” button in the lower center area of the window.

7. A message log window will open and start to scrolling indicating writing to the SmartWire is in progress.

8. Once completed, the message log window will show “**DEVICES PROGRAMMED SUCCESSFULLY**”.

9. Click **OK** and at this point, returned to the SM1 Inputs window.

10. Click **OK** on the SM1 Inputs window to return to the main configuration window.

11. At this point, terminate the A10 pin to a momentary pushbutton and wire the other side of the button battery power or terminate this at a later date.

   **Note:** Depending on how many outputs planned on using, it is possible to wire to another output from the SmartWire and trigger this output with an ignition switch programmed in a similar fashion.

   **Note:** If the input pin is wired at this point, click the “Start Real-Time Display” button to verify the signal when pressed. Since output is not configured at this point for this input, no activities occur.
Output Configuring (Walk through cont.)

An output channel will now need to be configured for the starter button input. This channel will activate the starter solenoid on the starter motor. Select an output with an appropriate current (Amps) rating by referring to the Channel Pin Chart located on the inside of the rear cover of this manual. The starter solenoid in most cases can draw up to 20 Amps. For this example, we’ll select Output #1 Pin A3.

1. In the main configuration window, right click on the channel button SM1 Output #1.

2. The first thing that should be done is to confirm this particular channel’s capacity is rated higher than the operating current (Amps) of the device that it is connected to. This is noted by verifying the Type: located in the top right corner of the window. 20A.

3. In the Channel Name text box, type in a name that represents what this input will be. For this example, we’ll type in O#1 Starter Solenoid. The name represents Output # 1 Starter for which the output will connect to. This will make it easy for future reference of this channel in later programming.

4. Take note of the Pin # for this input as this will be the pin on the 23 pin connector used for this button. This Pin # is located in the bottom left corner of the window. Pin# A3.

5. Verify and set the values for the output channel. These should be set to match the output connecting to. Below are values that specifically require attention.

   • **Fuse Current**: Setting this value below or slightly above the normal operating current of the device this output is connected may result in inadvertent shutdown of this output. These values should be set higher than normal operating current. The purpose of this is to protect the wire from overheating should the device fail. Some devices can draw more current under certain situations such as low battery voltage and increased demand/load.

   • **Fuse Reset Delay / Max Fuse Retries**: When an over-current or blown fuse situation occurs, the SmartWire will attempt to reactivate the output. The Fuse Reset Delay determines the amount of time after the fuse has blown before the output is re-activated. The Max Fuse Retries determines the how many times the SmartWire will attempt to reactivate the output.

   • **Output Function**: This sets the function of the output. Select the one that most represents the desired output. In most cases where on/off is the desired function, as in this example, **Constant On** should be selected.

6. Once these values are set, we can send this change to the SmartWire by clicking the “**SEND Configuration**” button in the lower right area of the window.

7. A message log window will open and start to scroll indicating writing to the SmartWire is in process.
8. Once complete, the message log window will show “DEVICES PROGRAMMED SUCCESSFULLY”

9. Click OK to return to the output channel window.

10. At this point the output is **NOT** completely configured. The settings have been done for this channel, but the channel has no logic giving it directions to activate. To do this, the **On Conditions** must be configured.
Logic Configuration (Walk through cont.)

An output channels name and parameters were setup and programmed in previous steps but requires certain conditions for the output to become active. These conditions are entered in the Logic area of the On/Off Condition window and are required to be configured before the output channel can be used.

1. In the output channel window, click on the button in the lower right corner labeled On Condition.

2. This window is where programming for this output channel is done. Up to ten inputs, sensors, or outputs connected to the SmartWire unit can be used to create multiple logic combinations to control the activation of the output.

3. In the Setpoint Control Channel area, select a Setpoint Control Channel by clicking on the drop-down arrow next to the channel =Disabled =(x0)

4. A list of channels will appear. These are the available channels to select from. By selecting a channel and clicking on the + sign next to it, this channel can be utilized for the logic area. (See Setpoint Control Channel section for more details)

5. Scroll down to SM1 Inputs and click on the + sign.

6. At this point, note a list of all switches under the SM1 Switches section.

7. Here we will select the previously configured Starter input labeled as HDWI#1 Starter.

8. As shown in the window below, select the Operation for this input to be True. For our example, the operation “Equal to” should be selected.

9. Since the Setpoint Control Channel is an input switch, the only options for switches are either On or Off. Each position has a value which is 0 = Off and 1 = On. The value to each input cannot be changed.

10. For this output channel, we want the output to activate when the switch is in the ON position (On = 1). For this to happen, we need to type in “1” (switch on) in the True Condition area for this Setpoint Control Channel. This basically states that when the input switch (Starter Button) in turned to the ON position (=1), the condition for this Setpoint Control Channel should become True.
11. In order to activate this output, the previously configured Setpoint Control Channel must be added to the Logic area on the right area of the window. To add this channel to control the output, **Right-click in LOGIC area** and select it. If multiple Setpoint Control Channels are configured, they will show up when right-clicked. **Be sure to select the desired selection.**

12. Once these values are set, we can send this change to the SmartWire by clicking the **OK** button on the On/Off Condition window. This will return to the output channel window.

13. Within the output channel window, click the “**SEND Configuration**” button in the lower right area of the window.

14. Once completed, the message log window will show “**DEVICES PROGRAMMED SUCCESSFULLY**”

15. Click **OK** to return to the output channel window.

**Understanding Basic Logic Flow:**

- Logic conditions are added or removed by right clicking in the Logic area.

- Basic flow of the Logic area is:

  
  $\text{IF} \quad \text{“Channel X” “&” “Channel Y” are both true, activate output}$

  $\text{OR} \quad \text{IF} \quad \text{“Channel Z” is true, activate output}$

- The “&” connects two logic conditions together meaning both would have to be **True** in order for the output channel to be activated.

- The “**OR**” separates the logic conditions.

If any Logic condition is True, the output channel condition would then become True and output channel would be activated.
SmartWire Firmware Update

Periodically, updates for the internal software on the SmartWire unit known as firmware is required. To perform the firmware update:

1. Download and save the appropriate firmware .zip file for the SmartWire from [www.racepak.com](http://www.racepak.com)
2. Once saved, unzip the .zip file.
   **NOTE:** Note where the unzipped .hex file is located when navigating to this location in later steps.
3. Apply power to the entire Racepak system.
4. Connect PC the system in one of the previous mentioned ways ([Standalone](http://www.racepak.com) or [With Data Recorder](http://www.racepak.com)) and open the car configuration file for the system.
5. Once the car configuration file is opened, **right click** on the Main SmartWire channel button to show the Main SmartWire Unit Settings.
6. Click on the Update button next to Firmware Version.
   **NOTE:** The currently installed firmware is shown in the dialog box, ensure the firmware installed is a greater number than the show number.
7. Click **Select** to the browse and locate the .hex file.
8. **Select** the .hex file and click **Open**
9. In the Firmware update window, click Start to start the update process.
   **NOTE:** While the unit is being updated, both **Status** and **Power** lights on the SmartWire unit will be **solid Green**. Should the **Status** light go off and **Power** light start flashing **Red**, the unit has not accepted the firmware. This could be cause by many things from a corrupt firmware file to an interruption during the flashing process. It is best to cycle the power off/on and restart the update. If problem continues, try re-downloading the firmware file from the website. If issue continues, the unit can be sent to Racepak for firmware update/inspection.
10. Once firmware update is complete a window will appear indicating a successful update.
### Channel/Pin Chart

#### Sorted by Pin Number

<table>
<thead>
<tr>
<th>PIN</th>
<th>CH#</th>
<th>Type</th>
<th>AMP</th>
<th>PIN</th>
<th>CH#</th>
<th>Type</th>
<th>AMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>4</td>
<td>Output</td>
<td>20</td>
<td>B1</td>
<td>5</td>
<td>Output</td>
<td>20</td>
</tr>
<tr>
<td>A2</td>
<td>10</td>
<td>Output</td>
<td>10</td>
<td>B2</td>
<td>22</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A3</td>
<td>1</td>
<td>Output</td>
<td>20</td>
<td>B3</td>
<td>7</td>
<td>Output</td>
<td>20</td>
</tr>
<tr>
<td>A4</td>
<td>11</td>
<td>Output</td>
<td>10</td>
<td>B4</td>
<td>28</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A5</td>
<td>13</td>
<td>Output</td>
<td>10</td>
<td>B5</td>
<td>25</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A6</td>
<td>2</td>
<td>Output</td>
<td>20</td>
<td>B6</td>
<td>8</td>
<td>Output</td>
<td>20</td>
</tr>
<tr>
<td>A7</td>
<td>15</td>
<td>Output</td>
<td>10</td>
<td>B7</td>
<td>26</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A8</td>
<td>3</td>
<td>Output</td>
<td>20</td>
<td>B8</td>
<td>6</td>
<td>Output</td>
<td>20</td>
</tr>
<tr>
<td>A9</td>
<td>12</td>
<td>Output</td>
<td>10</td>
<td>B9</td>
<td>21</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A10</td>
<td>1</td>
<td>Input</td>
<td></td>
<td>B10</td>
<td>7</td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>A11</td>
<td>3</td>
<td>Input</td>
<td></td>
<td>B11</td>
<td>8</td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>A12</td>
<td>4</td>
<td>Input</td>
<td></td>
<td>B12</td>
<td>9</td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>A13</td>
<td>5</td>
<td>Input</td>
<td></td>
<td>B13</td>
<td>10</td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>A14</td>
<td>6</td>
<td>Input</td>
<td></td>
<td>B14</td>
<td>11</td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>A15</td>
<td>20</td>
<td>Output</td>
<td>10</td>
<td>B15</td>
<td>27</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A16</td>
<td>9</td>
<td>Output</td>
<td>10</td>
<td>B16</td>
<td>18</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A17</td>
<td>19</td>
<td>Output</td>
<td>10</td>
<td>B17</td>
<td>24</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A18</td>
<td>2</td>
<td>Input</td>
<td></td>
<td>B18</td>
<td>12</td>
<td>Input</td>
<td></td>
</tr>
<tr>
<td>A19</td>
<td>NA</td>
<td>ground</td>
<td></td>
<td>B19</td>
<td>NA</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>A20</td>
<td>NA</td>
<td>ground</td>
<td></td>
<td>B20</td>
<td>On/Off Shutdown*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A21</td>
<td>14</td>
<td>Output</td>
<td>10</td>
<td>B21</td>
<td>23</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A22</td>
<td>16</td>
<td>Output</td>
<td>10</td>
<td>B22</td>
<td>29</td>
<td>Output</td>
<td>10</td>
</tr>
<tr>
<td>A23</td>
<td>17</td>
<td>Output</td>
<td>10</td>
<td>B23</td>
<td>30</td>
<td>Output</td>
<td>10</td>
</tr>
</tbody>
</table>

*Grounding the Shutdown pin will turn off power to the SmartWire unit and all outputs.

#### Sorted by Channel Number

<table>
<thead>
<tr>
<th>CH#</th>
<th>Type</th>
<th>PIN</th>
<th>AMP</th>
<th>CH#</th>
<th>Type</th>
<th>PIN</th>
<th>AMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output</td>
<td>A3</td>
<td>20</td>
<td>5</td>
<td>Output</td>
<td>B1</td>
<td>20</td>
</tr>
<tr>
<td>1</td>
<td>Input</td>
<td>A10</td>
<td></td>
<td>6</td>
<td>Output</td>
<td>B8</td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>Output</td>
<td>A6</td>
<td>20</td>
<td>7</td>
<td>Output</td>
<td>B6</td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>Input</td>
<td>A18</td>
<td></td>
<td>8</td>
<td>Input</td>
<td>B10</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Output</td>
<td>A8</td>
<td>20</td>
<td>9</td>
<td>Input</td>
<td>B12</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Input</td>
<td>A11</td>
<td>20</td>
<td>10</td>
<td>Input</td>
<td>B13</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Input</td>
<td>A12</td>
<td>10</td>
<td>11</td>
<td>Input</td>
<td>B14</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Input</td>
<td>A13</td>
<td>12</td>
<td>9</td>
<td>Input</td>
<td>B18</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Input</td>
<td>A14</td>
<td>12</td>
<td>18</td>
<td>Output</td>
<td>B16</td>
<td>10</td>
</tr>
<tr>
<td>9</td>
<td>Output</td>
<td>A16</td>
<td>10</td>
<td>21</td>
<td>Output</td>
<td>B9</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>Output</td>
<td>A2</td>
<td>10</td>
<td>22</td>
<td>Output</td>
<td>B2</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>Output</td>
<td>A4</td>
<td>10</td>
<td>23</td>
<td>Output</td>
<td>B21</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>Output</td>
<td>A9</td>
<td>10</td>
<td>24</td>
<td>Output</td>
<td>B17</td>
<td>10</td>
</tr>
<tr>
<td>13</td>
<td>Output</td>
<td>A5</td>
<td>10</td>
<td>25</td>
<td>Output</td>
<td>B5</td>
<td>10</td>
</tr>
<tr>
<td>14</td>
<td>Output</td>
<td>A21</td>
<td>10</td>
<td>26</td>
<td>Output</td>
<td>B7</td>
<td>10</td>
</tr>
<tr>
<td>15</td>
<td>Output</td>
<td>A7</td>
<td>10</td>
<td>27</td>
<td>Output</td>
<td>B15</td>
<td>10</td>
</tr>
<tr>
<td>16</td>
<td>Output</td>
<td>A22</td>
<td>10</td>
<td>28</td>
<td>Output</td>
<td>B4</td>
<td>10</td>
</tr>
<tr>
<td>17</td>
<td>Output</td>
<td>A23</td>
<td>10</td>
<td>29</td>
<td>Output</td>
<td>B22</td>
<td>10</td>
</tr>
<tr>
<td>19</td>
<td>Output</td>
<td>A17</td>
<td>10</td>
<td>30</td>
<td>Output</td>
<td>B23</td>
<td>10</td>
</tr>
<tr>
<td>20</td>
<td>Output</td>
<td>A15</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NA</td>
<td>ground</td>
<td>A19</td>
<td></td>
<td>NA</td>
<td>Ground</td>
<td>B19</td>
<td></td>
</tr>
<tr>
<td>NA</td>
<td>ground</td>
<td>A20</td>
<td></td>
<td></td>
<td>On/Off Shutdown*</td>
<td>B20</td>
<td></td>
</tr>
</tbody>
</table>

*Grounding the Shutdown pin will turn off power to the SmartWire unit and all outputs.